War Over the Mideast Getting Started

This file will help you get started quickly with War Over the Mideast. If you have
just installed the game, then the Main Program should be running. Otherwise,
to run the Main Program, click on the icon created on your desktop. You can
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Dezcription

Thiz iz the Getting Started scenarno for War Over the Mideast. Use thiz zcenarno to leam the basics of play
i conjunction with the Getting Started Help File, which you can digplay from the Help Menu, Your goal in
thiz scenarnio iz ta fly a strike mission against the enemy radar installation while defending against any
fighters which are zcrambled to intercept.

| k. | Cancel Help

By default, after the introduction, the Main Program begins by prompting you for the name of
the file to open using the File Selection Dialog. We will be playing a hypothetical scenario
designed to illustrate several features of the game. In the list of files displayed by the File
Selection Dialog, select 00000000 _spreadwings.scn. You can read a short description
about the scenario at the bottom of the dialog. When finished, click on the OK button.

ection Dialog
lsrael Arab
&+ Marual " Marual . . )
Next, the A/l Selection Dialog will appear. Select
© Automatic £ Automatic Israel Manual (default), Arab Automatic with FOW
O automatic with FOW || % Automatic with FOwW (Fog Of War), then click the OK button. Once you

ok | Rules... Help |




have the scenario selected and sides chosen, you will be presented with a map of mission
area, which includes Israel, Lebanon, Syria and the eastern Mediterranean. The “Spread
Wings” scenario includes two Israeli airbases, a command center and search radar, with the
same elements duplicated on the Arab side. The two airbases each have one flight of two
aircraft: One flight configured for air superiority and the other for ground strike. As the Israeli
player, your mission is to bomb the Arab radar and safely return home. The Arab force may
scramble its fighter flight to intercept if you are detected, so you should plan on having your
air superiority flight escort the strike flight and engage any Arab fighters.

In the lower right-hand corner of the screen, you will see the Jump
Chart which displays the overall situation. Any blue dots that
appear represent Israeli flights. Any red dots you happen to see
there will be Arab (in ths case, Syrian) flights. The red rectangle
indicates how much of the overall situation is visible on your Main
Chart, which is the larger display on the screen. Click anywhere
on the Jump Chart and the Main Chart will automatically scroll to
that location.

You can zoom in and out on the Main Chart in two ways:
. If your mouse has a scroll wheel, you can roll that to zoom in and out.
. You can use the hot keys 1, 2, 3, 4 and 5 to jump to that zoom level.

Also notice that if you move the mouse to the edge of the screen while zoomed in, then the
Main Chart will scroll in that direction.

The two lIsraeli airbases are Tel Nof (with a flight of F-15C
Akefs) and Hatzerim (with a flight of F-151 Raams). To the north,
the Syrian airbases are Al Qusayr (with Su-27 Flankers) and
Sayqal (with MiG-29UB Fulcrums). The location of our mission
objective (a “Bar Lock” search radar) is currently unknown, so
our forces will have to find it before conducting an attack. To
launch a flight from either Israeli airbase, simply double-click on the
desired airbase and the Air Base Dialog will open.
Let’s launch a flight from each base. As described on
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the dialog box, double-click on any aircraft flight you
wish to launch (the only flight in this case), to select it

and the dialog box will disappear. You could also
_ Ouess | click once to select a flight and then click the “Orders”
Pl button to choose a destination from any preplanned
routes, but this scenario is open-ended and no plans

Image have been made yet.
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a remaining range of 4130 nautical miles and an armament of twelve AIM-120B and four
Python 5 air-to-air missiles. The AIM-120B’s are shown in orange because they are the
current weapon selected for launch. AIM-120B missiles use active-homing radar seekers,
indicated by the (*A) following their name, which means that you can “fire-and-forget” at
targets during combat. The Python 5’s are short-range, IR-homing missiles which are
intended for dogfighting.

Next, select an area on the map where you wish your flight to head. This can either be an
empty space on the map, a friendly flight you wish to follow, or target you wish to attack.
Simply right-click anywhere you choose on the map to launch a flight and a white line will
appear. This indicates the selected flight’s current orders. By default, the number displayed
at the end of each line segment is the time required to reach that point, though this can be
changed to show distance. Launch both your F-15C Akef and F-151 Raam flights to the
northwest and head them out over water above the Mediterranean.

Notice that you can control the speed of the game using the Run Time RUN TIME
buttons Ox through 10x. In this game, Ox means paused, although orders
can still be given in this state. 1x means the game will run in real-time and
each increasing speed means that the game will run in that multiple of real-
time. You can also toggle the running and pausing of the game by pressing Save
the space bar. Below this section of the interface are buttons to Load a new b
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Once both of your flights have launched, plan on routing
them north toward your mission search area. The easiest
way to command them to do this is with the Flight Orders
Menu. With a flight selected, hold down the Shift key and
Right-click on the Chart. A list of commands you can use
will be displayed. Unlike right-clicking directly on the map,
you can chain together multiple orders this way. All orders
are given in sequence unless overridden with immediate
commands by right-clicking directly on the map. Shift and
right-click on an area north of your flights and select “Fly
To” which will set a route O T rani i T 4 Ancraft Hange

waypoint. Statils IMETI Griound Radar,
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Under the View Menu at the bottom of the screen, you can  jaiguilant fli=sins
select “All Orders” to see the white route lines and attack fg:fg:::ﬁ?:;ﬁ
orders given to all flights at once. Otherwise, these will
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only appear when a flight has been selected. You can also highlight “Missions” from the
same menu box to toggle a color-coded box around each of your flights. Your Raam flight,
for instance, will have a black box indicating their [Strike] mission, and your Akef flight will
have a blue box indicating [Air Sup]. The hotkey “A” can also be used to toggle all text labels
seen on the Chart.
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With our flights airborne, we can now take a closer look at the various orders we can give
them en route. After selecting our flight of F-15C Akefs, we can see that they are currently
set to fly at a speed of 480 knots and at CRU (Cruising) altitude. These values can be
changed by clicking on the other settings nearby, or have them change settings at waypoints
by selecting the appropriate option on the shift right-click flight orders menu (Fly High, Fly
Low, Inc Speed and Dec Speed).

For the aircraft shown above, the two available altitudes are:

CRU - Cruising altitude. Encompasses most normal flight and combat operations.

LOW — Low altitude. This is as low as the pilots are are willing to dare. Flying at low
altitude increases fuel consumption but reduces land-based radar detection range to
the brown circle displayed.

(Note that some special aircraft, such as the SR-71 Blackbird, can have a third, extra-
high altitude such as space or near-space. More modern aircraft, such as your F-15I
Raams, can use terrain-following radar to fly even lower at NOE, or “nap of the
Earth.”)

The four available speeds are:

360 kts — Loiter speed. The lowest speed, used to conserve fuel.
480 kts — Cruise speed. This is your normal operating speed.

527 kts — Military Power. Use this speed when you need to go as fast as possible
without resorting to afterburners. For aircraft without afterburners, this is the highest
possible speed.

960 kts — Afterburners. Use this speed with caution as it very quickly burns fuel.
External fuel tanks are often jettisoned to reach this speed.

Note that when you change altitudes and speeds, the remaining flight range of your aircraft
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increases and decreases accordingly. On the main chart, this is also depicted by a large,
black circle when the flight is selected. Since these fighters have generous fuel reserves and
external tanks, this circle will not appear until much more fuel has been burned off.

With your flights over the sea, the colored lines
that appear when they are selected are now
more visible. Yellow indicates radar coverage,
while red indicates the range of the currently
selected weaponry. The blue circle reflects
visual range, within which most targets can be
detected and identified. At low altitude, a brown
circle indicates the distance to the horizon,
which is useful when avoiding ground-based
radar and SAM sites. Many different colors
exist for the ranges of other systems, such as
the teal circle around your F-151 Raams
indicating ELINT (Electronic Intelligence), which
can detect and identify targets at a distance.

15" Raam

Many of these colored regions can be affected by different flight orders. Selecting different
weapons changes the red weapon range, while changing altitude can sometimes affect
radar and other systems. Usually, low altitude will not affect the maximum range at a
distance, but will cap detection range at the horizon against other targets that are also at low
level.

As we approach the enemy’s airspace, it may be prudent to avoid flying at high altitude so
as to avoid detection. Plot your flight paths northward and plan a turn northeast toward the
ridgeline west of Al Qusayr airbase for both flights. Since we do not have any information to
go by yet, you will be refining this flight plan later as your sensors detect enemy units.

Keep your F-15C flight out ahead of the F-15I flight with AIM-120B AMRAAM s selected. The
Command Menu at the bottom of the screen includes an option for Auto-Fire. With this
highlighted, the F15C’s will automatically fire on any target which enters firing range. Auto-
Intercept will also override any existing orders and cause them to fly directly towards the
nearest detected threat. If both options are left off, you must direct your fighters at the target
manually and launch missiles manually by holding down the left Control key and right-
clicking on the target within range.

Gommand Menu| | Drop Fuel Tanks [AutoFire
onotiPassengens Autu-Returr.k
LLoad Gango
Unload Gango
setiMission
Establish O]

Change Load-0ut
Set lakeoft lime
Set Package
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Meanwhile, the F-151 Raams will be using their BSU-50 Ballute bombs when they detect the
location of the radar site and execute the attack. The player doesn’t need to manually select
bombs when attacking a ground target with air-to-ground ordnance, as the aircraft will
change weapons automatically, but this may still be necessary if you wish to choose one
type of ordnance and save a different one for later strikes. For self-defense, the Raams
should be flying the route with their own AMRAAMSs selected. On the attack run, they will
automatically switch over to bombs.

A (Bkayr

While your two flights are following their assigned paths, you can “pop” them up and down
momentarily so your sensors will get a better view of the target area. Your Raams are also
equipped with both ELINT (teal circle) and air-to-ground radar (same area as the air-to-air
radar), which make them far better detectors than the Akefs. They could be left at high
altitude to provide sensor data that the Akefs, still hidden at lower altitude, can take
advantage of.

54,0'_Akef
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In the picture above, the Raam flight has popped up and its synthetic aperture radar has
detected a structure outside Damascus. ELINT gear has identified its emissions as coming
from a command center. The radar we are attempting to destroy on this sortie is no doubt
feeding information to this location. We could try knocking out this command center, greatly
disrupting enemy activity across the whole region, but such targets are often fortified and
well protected by AAA (Anti-Aircraft Artillery) and SAMs (Surface-to-Air Missiles). For now,
we’ll stick with our original objective. Pop the Raam back down to NOE altitude and continue
flying north. After a few more miles, pop it back up for another peek.

-1 fi!_hia am

After a few more miles, the Raam flight detects the enemy radar as it drifts into range of
ELINT receivers. With its location (and its detection range) confirmed, the radar can now be
targeted for an attack and the F-15’s can remain at low altitude for the remainder of the
sortie. With the Raams selected, you can delete any flight plan leg that doesn’t head toward
the radar (Shift, right-click, “Delete”) then either right-click directly on the radar or Shift, right-
click on the radar and select “Attack” from the flight orders menu. This will put a red box on
the target. The order will be carried out even after contact is lost with the radar by going
back to low altitude.

Our Raams will make a high-speed, low-altitude pass on the radar and drop their bombs, but
our Akefs cannot follow. If they get too close to the radar (within the brown circle) they will be
detected. Syrian fighters would no doubt be scrambled from the nearby airbase. We still
want to provide cover if necessary, however, so keep your Akefs’ flight plan close by and
have the Raams return to them as soon as possible.
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So far, there has been no enemy response and our Raams are poised to strike. Increase
their speed to maximum (afterburners) and let them make a pass on the radar. The Akefs
should be kept milling around nearby, either by reducing their speed, dragging out their flight
path or by using the “Patrol” order (flight orders menu) to have them move back and forth
between two designated points. The Patrol Dialog will ask for a holding time, measured in
minutes:seconds. Leaving this set to 0:00 will result in an indefinite holding pattern.

If the Raams could not attack so stealthily, or if enemy aircraft were maintaining a defensive
CAP (Combat Air Patrol), it would have been more prudent to keep the Akefs moving
towards the Arab airbase at Al Qusayr, ready to respond to any threats on a moment’s
notice. As things stand, we won’t have to chance it.



100% to BSU-80_Ballute

The BSU-50s were a good choice of munition for this target.
Since their descent was slowed down by ballutes, they
allowed the Raams to drop at very low altitude, without
being engulfed by the detonations. Our fighters went in and
got away before the enemy knew what hit them. With the
radar destroyed, the only other possible detectors would be
radars located at airbases and those mounted on any
airborne fighters. The ELINT systems on our Raams have
not detected any radar coming from the airbases (which
would have appeared with yellow circles around them) nor
have they found any airborne emissions (which would
appear as green lines radiating out towards the emitter).
From the looks of it, we could easily return home now
without a scratch. A flight path order can be given to

“‘Return,” which will send the aircraft back to their starting e
location (home base), or you can right-click on any other Concel
airbase, or give the “Land” order, to return to a different

location.

= DR But perhaps we’re not quite done? A glance at the Victory Progress bar
= at the bottom right of the screen, just above the Jump Chart, shows that
we have not yet scored a “major” victory. That would have meant the bar
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was totally filled. Using the View Menu at the bottom of the screen, we can click on “Victory
Condition” to look at the Victory Dialog and see why this is the case. It would seem that
destroying the radar installation alone was only sufficient for a “minor” victory. Clearly, high
command expects us to do more than that after all. It's time to see what our fighter pilots are
really made of.
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With our two flights rejoined, let’s turn them around and see if we can’t get some of the Arab
fighters to launch. Going back to normal cruising altitude, let’s start with their air superiority
base at Al Qusayr. With no radar to provide early warning, we can expect the airbase to
detect our fighters once they are within visual range (blue circle). This is very dangerous,
since at such close range we will not be able to take advantage of our AIM-120B missiles.
Had we alerted the enemy earlier, it could have resulted in a typical BVR (Beyond Visual
Range) engagement. Even so, for this example, we will press onwards to see what happens.

11

At eight nautical miles, we have reached the
airbase, where events take place very
quickly. The black circle around the base
indicates the range of defensive weaponry
such as AAA, which we are still safe from.
However, as soon as we arrive, an enemy
flight scrambles and opens fire. Their
missiles are depicted as black dots with
white trailing lines. In a few moments, our
fighters pick up the “bandits” which are
immediately identified as two Su-27
Flankers. The vyellow circle that appears
indicates that they are within our weapons
range and are “locked up,” valid targets to
attack.
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Both of our flights have launched missiles as well using the Auto-Fire setting. Our Akefs
were closer and engaged with Python IR missiles, while the Raams fired some of their AIM-
120B AMRAAMs instead. Both are fire-and-forget. The Su-27s are only attacking our Akefs,
leaving the Raams free to pursue.

Although dodging or “trashing” missiles at this range is far easier said than done, we can
maximize our chances of survival by “dragging” the enemy flight with our engaged fighters
while simultaneously pressing the attack with the rest of our formation. Using the Ox pause
function to give these split-second orders, send the Akefs away from the incoming missiles
at maximum speed, buying the most possible time. Notice that they will drop their external
fuel tanks in the process to free up the excess weight and drag. The Raams should be
directed at the enemy flight and also have their speed increased to full power. By default,
aircraft that automatically engage will only fire one salvo at a time: An enemy flight of two
meant each of our shots consisted of two missiles. Since Pythons and AMRAAMs are fire-
and-forget, we don’t need to “support” those missiles to the target and are free to fire more
just in case the first ones fail. Using your Raams, hold left Control and right-click the
enemy flight to manually fire a second wave of missiles.

Enemy flight lost 2 alreraft to Pythons The enemy Su-27s “switched” to our
Raams at the last second, but with six

missiles bearing down on them it was too
late to matter. Both were “splashed” to
the Pythons, wasting all four of our
AMRAAMs that were also fired. This
made for an expensive exchange, but
losing aircraft would have been even
worse. Meanwhile, our flight of Akefs
managed to evade the missiles fired at
them, making the whole engagement a
“clean kill.”
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il The Victory Progress bar is still not full, so

we’ll repeat this performance at Sayqgal. This

. time, however, the enemy refuses to take off,

perhaps because the enemy knows the odds

are stacked against them. We can’t launch

Pythons or AMRAAMSs at ground targets, but

we’re not out of the fight just yet. Both of our

Bingo. WAhchesterl Refdeling flightg are equipped with 20mm. cannons,

Can Strafe ELINT granting them the “Can Strafe” attribute seen

underneath their aircraft pictures. Although the

enemy airbases have some form of AAA defenses, we can try shooting the enemy aircraft

as they sit idly on the ground. Push both flights up to maximum speed and right-click on the

airbase. The Airbase Targeting Dialog will appear, giving us multiple options. We don’t

have the right kind of ordnance to attack the hard, concrete Runways, nor are we interested

in attacking the ammunition stores of the Buildings. To attack the Entire Air Base would

distribute damage evenly, which would also not be ideal. Rather, we will target both of our

flights towards the Ramps, where the enemy aircraft are parked. So long as the airbase
doesn’t have any hardened aircraft shelters, we may be able to catch their jets in the open.

=
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ELE| T &ir Base Targeting Dialag

‘%I Select zpecific target at air baze:
Entire Air Baze | Funways Only Flamprilzlnl_l,l Buildings Only
g
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Arab Saygal lost 3% of ramps to strafing
Arab Sayqal lost 4% of ramps to strafing

Fortunately, their AAA defenses were unable to score any hits on our fast, highly-
maneuverable fighters. Unfortunately, despite having caused some damage to nearby
assets like fuel trucks and hangars, we failed to destroy any aircraft this time. Our fighters
only reserved enough ammunition for a single strafing attempt, and so “Can Strafe” is no
longer highlighted. We’ll have to return to base in order to re-arm, but the fourteen minutes
left in this scenario won’t be enough time to do so. We’'ll have to settle for that minor victory
after all. Perhaps you could have done better?
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Synchronizing and sequencing both attacking and supporting elements is an intricate
operational art, often learned through trial and error. In our example, we relied on superior
technology and tactics to hit the target without the enemy being able to respond. This will not
always be the case. You are encouraged to replay this scenario without relying on the low-
altitude performance of the F-15I’s, baiting enemy fighters into attacks out in the open. You
can also experiment with targeting different objectives, such as knocking out the Ops Center
first, or hitting airbase ramps with bombs. Lastly, you can fly the scenario from the Arab side
instead, which will give the opponent a distinct technical advantage.

To learn more about War Over the Mideast and Modern Air Power game series at this point,
you should refer to the following manuals:

¢ Quick Reference (.pdf) — This is a one-page reference of the basic commands you
need to know.

e User Manual (Userx.pdf) — This is a complete reference of gameplay features in
Modern Air Power.

e Main Program Help File (Mapx.pdf) — This help file covers the game interface and
various simulation calculations in greater detail.

e Scenario Editor Help File (Apedit.pdf) — This help file covers features which are
specific to the Scenario Editor.

e Order of Battle Editor Help File (Apoob.pdf) — This help file covers the features of
the Order of Battle editor.

o Parameter Data Editor Help File (Apparam.pdf) — This help file covers the features
of the Parameter Data editor.

For Product or Support inquires please contact HelpDesk@wargameds.com
https://wargameds.com/

14


mailto:HelpDesk@wargameds.com
https://wargameds.com/

